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1. Intro

This chapter describes the workflows where you use Automation Engine to send data to be produced
on an Esko Kongsberg cutting table.

Important: This chapter assumes you are familiar with a Kongsberg cutting table and it's front end
application iPC (i-cut Production Console). Learn more in the On Line Help of Kongsberg iPC.

Note: These workflows require that the version of iPC is v2.0 or higher.

1.1. Workflow Overview and Types

Workflow Overview and related Pilot Views

When you set up a Kongsberg table as a Device in Automation Engine, you can send cutting data to it's
iPC by using the Submit to Kongsberg Table task.

The iPC operator sees these items appear in his "My Job List"and can decide when to start its
production. The iPC communicates back to Automation Engine about the status of this job and the
attributes used for its production.

Note: EachiPC is dedicated to one table.

These Pilot Views are used in Kongsberg workflows:
* ¥ Devices shows your Kongsberg tables (and CDI imagers), their general status and their workload.

* D= Table Queues shows the queue of each of your Kongsberg tables in a time line or list view. You can
re-order and delete entries.

. Sheets shows a historical overview of all jobs that were processed on your Kongsberg table(s).
You can resubmit them and you can export (parts of) this history to an XML file to be interpreted by
external systems (order management, calculation, etc.).

Orders(part of the Views category Sign & Display). This view shows an overview of the status

of all parts of a Job order that were processed by the Gang Run Merger. It helps to monitor orders
where multiple graphics need to be printed and cut. This view is documented in the chapter on Gang
Run Printing for Sign & Display.

Workflow Types

Kongsberg tables are used in many different types of production. When using Automation Engine in
this workflow, we here categorize these workflows by how and which files you submit to the iPC:

« Submitting single CAD files. Each CAD file (ARD or MFG) becomes an item in iPC's My Jobs list.

« Submitting nested layouts. The iPC Job is a layout created by the Gang Run Printing module.
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« Cutting CDI Plates. Typically done to cut DFS PlatePatcher plates (corrugated) or to produce
staggered cut plates (rotative sleeves).

imaged plate

s
o D DS

staggered cut

e Y o oo o)

1.2. Submitting Single CAD Files

Concept

In this workflow, Automation Engine sends ARD of MFG files directly to the iPC. Each input file arrives
asone jobintheiPC My Job list.

This workflow is often used when producing packaging, POP material or box samples.

Automation Engine

0 Submit to

n Kongsberg table |_— ' _
ARD _ i

task .
MFG v '

A

These are its main steps:

1. The ARD or MFG file may be created in ArtiosCAD or exported from Plato or i-cut Layout. The MFG
may be the result of manual nesting done in those applications.
2. There may or may not be graphics involved:

a. From such interactive applications or via an Automation Engine task, the graphics (PDF data)is
exported as well and then printed. The printed sheet is made available at the Kongsberg table.
b. When producing blank samples of a box or shape, there are no PDF data and the required
material is available at the Kongsberg table.
3. The cutting file is sent to the iPC by using the Submit to Kongsberg Table task. You there choose
the table, the amount of copies and other production parameters.
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Main Workflow Steps

1. Submit ARD or MFG files to iPC. Learn more in Submit To Kongsberg Table task on page 16.

2. When successfully submitted, an entry appears in the Table Queues view.

3. The iPC operator places the printed or blank sheet on the table and starts the matching cutting job.
An entry appears in the Sheets View.

1.3. Submitting Nested Layouts

Concept

This workflow merges files together before submitting them as one layout to the iPC. The merging is
done by the Gang Run Printing merger. This merger can also make layouts where items are nested to
optimize material usage.

This workflow is often used when producing signage.

Automation Engine

S Submit to
0 Gang Run Printing Kongsberg table
B substrate X task —
PDF Export g r
=p | [H Substrate Y Nested Va
ARD B substrate 7 e Cutting files
upstrate ==
" Print files

Note: ARD cad files sent to this merger will only merge with other ARD files.

Main Workflow Steps

1. Inthe Gang Run Printing merger, set up merge queues per substrate, define how and when they can
make layouts and how they should export the resulting nested layout.

Note: This tool and workflow is explained in the chapter Gang Run Printing for Sign & Display.

2. Youthen use the Submit to Gang Run task to send files to a substrate queue.
3. The substrate queue's output workflow needs to contain at least these tasks:

« The Export Nested Layouts task creates print files that are then printed (unless the layout is of
ARD files) and it also creates cutting files of the type "JDF (Kongsberg)".

« The Submit to Kongsberg Table task then needs to submit the cutting files to the Kongsberg
table.

An example:
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Copyto Printer
Cutting Filas
gty v
Start e
Layouts @ Submit to oK
o Kongsberg Table

4. Assoon as the JDF cutting file is submitted to the iPC, an entry appears in the Table Queues View.

5. TheiPC operator places the print on the table and starts the matching cutting job. An entry appears
in the Sheets View.

Tip: To easily find which cutting job matches which print job,you can use the i-cut Marks in |-cut
Layout to add a special barcode to the printout that contains the name of the cutting file. When the
iPC operator then scans that barcode, iPC automatically loads the matching cutting job.

Note: See a more detailed example of such a workflow at the end of this chapter in Workflow Example
on page 20.

1.4. Cutting CDI plates

Concept

In this workflow you use a Kongsberg table to cut a flexo plate that you made on a CDI. This is often
used when the flexo plate contains separations with a staggered cut or contains small parts of a DFS
PlatePatcher workflow.

Note: Learn more about using Automation Engine to automate your CDI workflow in the chapter Flexo

CTP Workflow.

Automation Engine iPC
Submit to

0 CDI Plate Merger Kongsberg table

_ task P
LEN files 8 Q for plate type A -7

Cutting files
# Q for plate type B -«

# Q for plate type C ==» Merged Plate  [Z22528 ' = + plate
LEN file Bhnnin = processing

The output workflow of a CDI Merge Queue creates a special XML file containing the cutting
instructions. When the CDI sends a signal that the (merged) plate was imaged, a workflow starts that
submits that XML file to the Kongsberg table.

Main Workflow Steps

1. ARIP creates LEN files, one for each separation that needs to be imaged on the flexo plate.
2. If needed, LEN files can be processed using specific Automation Engine tasks.
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They are then submitted to a specific queue of the Plate Merger. Selecting the option Apply cutting
workflow triggers the generation of the cutting data further in the workflow.

Note: The option Apply cutting workflow is also used as a grouping key in the Plate Merger.

. When the Merge Queue decides on a layout, it starts a workflow that creates a Merged Plate LEN

file. Now, as was requested when submitting its parts, also a cutting XML file is created.
The merged plate LEN file is submitted to the CDI.

When the CDI signals that the plate was imaged, the cutting XML file is automatically submitted to
the Kongsberg's iPC (when this was so asked in the CDI Plate Merger configuration).

Note: The flexo plate cutting workflow is also possible when the Kongsberg table is not known
as aDevice(i.e. itsiPC is not on-line). Learn more in the description of the option 'Apply Cutting
Workflow' in the Submit to Plate Merger task.

The flexo plate is post-processed and then moved to the Kongsberg table.

The cutting job is already in the iPC My Jobs list. The iPC operator loads the plate and starts the
cutting.
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2. Kongsberg Related Views

These views were introduced in Workflow Overview and Types on page 3. We here describe them in
detail.

2.1. Devices(Kongsberg)

Tip: You can also open the view Devices as a Tool: Go to Tools > Devices to monitor and manage your
devices in a separate window.

Adding a Kongsberg Device

Follow these steps to add a Kongsberg table in this view:

In Devices View, click on E2°,

Select the category Kongsberg Tables.

In Server, enter the name of the computer or the IP address of the iPC workstation of that specific
Kongsberg table.

Click Add to confirm. The status box of the newly created device appears.

Note: Adding a Kongsberg device requires a license per device.

Information and functionality

The device status box shows:

The name of the device. By default this is the name of the iPC workstation. Open the Info panel to
change it to a custom name.

The amount of jobs in its queue. This is the amount of jobs in iPC's My Jobs list (processing and
waiting).

Note: These jobs could have been added via Automation Engine or manually by the iPC operator.

A device statusicon.

: Retrieving the status.

: Offline, there is no connection with iPC computer (switched off, network problem)
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Note: Technically this means that Automation Engine can not contact the "Kongsberg Queue
Server"(KBQS).

: The device is online (computer can be accessed, KBQS is running) but the iPC application is
not started.

: Idle, the table is online and ready to produce (KBQS is running and iPC is started).
: Producing. One job in the queue is in status 'started'.
: Trying to connect to the device (to the KBQS service on the computer).

+ The Estimated time when the current job load will be finished (how long the device is scheduled to
be busy). This time includes the manual table operations that are needed between jobs.

Note: This setup time is configured in iPC: Go to Edit > Options > Estimation Settings.

Double click a status box to open the device's Info panel.

Right-click a status box to choose one of these options:

* Info(or press @). This dialog shows details about the device (version, settings, etc.). You canadd a
Description to illustrate or help identify this device.

* Delete (or press &). You will be asked to confirm.

Note: Deleting a device will not remove the related entries in the Sheets View.

* New Device.... An alternative to clicking E=°.

2.2. Table Queues

Concept
This view shows the content of the My Jobs list of the iPC of the Kongsberg tables that you configured
in the Devices view.
You can see these queuesin atime line view orin alist view.

The total number of jobs is mentioned in the bottom bar.

When a table is not on-line, an @ icon appears behind its name and the corresponding queue will be
shown empty. The view updates as soon as the table is on-line again.

When selecting ajob (click or use arrow navigation), the right pane shows a preview and its key
properties. When ARD or MFG files were submitted, a preview will only be available after the job was
verified or saved in iPC.

Note: The right pane will also show the number of Copies Produced and Copies Rejected of this
sheet/layout. An IPC operator can set this can set this manually, for example when a knife broke. These
numbers are also shown in a column in the Sheets view.

This view is independent from whether the Pilot is in Container mode or in Selected Job mode (it
always shows the complete queue).
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File Edit View Go Job Tools Advanced Help
< > |= & = |Containers v @0 &= [ o
| [ Files (WDE G... | {5 Tasks | = Sheets )= Table Queues ¥ Devices (WD... + |
[# General Kongsberg Tables 7 " e ' ' ' " amem ' ' ] T 1. 11 & T ]
g;omr;e[r;lall Print Small XE W g | E||6r 8| 10005 ba | |10074 EE%%%%%%%%%
gn & Display _
i@ Orders XN §375_| A3A A3A o cut| |Te| Tem || T 6923  |Tes |Tes |Te |Te |T| 6335_| |63 |63 | 69 nn n n[ﬁ [ﬁ m[ﬂw ﬁ n Hn
CT;EFIGang Run PI'|I'IﬁI'Ig HP1 W T E||&p| 8| 1000 | ba | [10075 nﬂﬁﬂmmmﬁmmmm
BN el NNGGARERANNAR
Sy ’ R 0 O
J&= Table Queues
= Setup Name: Test_2000x2000_1_7240.jdf
u_:l.‘ 22‘:;?:5 Material: Test
;7 Queue Monitor Quantity: 1
= Containers State: Ready for production
& Access Points Finishes at: 5:05 PM
¥z Customers Cutting Profile: SBS 350g
4 Users T'ooling Preset: Static Knife (Single Edge)
Optimization: No Optimisation
Production Setup: ¥ 7 )L b
1 of 64 selected Server: RDVMAELY User: wde (215

3| Time Line View

« Theredvertical line represents the current time. After selecting an entry, you can use your
keyboard's arrow buttons to pan over the time axis to see details of the other scheduled jobs in
that queue.

« Whenajobisbeing processed on the table, the time line view shows that job entry moving
gradually to the left of the red line. When the job is completely produced on the table, the entry
will have moved completely to the left side and disappear from this view once the iPC operator
closes the job (confirms that all copies have been produced).

« The default color of ajob entry is blue. Learn about conditional coloring below.

« Thesize of ajob entry reflects the job's estimated duration. iPC can only deliver this info when
the job is Ready for production. Learn about the different statuses below.

When an iPC operator still needs to prepare that job in iPC, its estimated duration is not available
yet. It is then shown with a default width (corresponding to 10 minutes) and filled with a striped

chocolat | | Box_BACKSTAGE

pattern. See this example where the entry on the right is not ready yet:

Use the slider 1 to increase or decrease the size of the queue entries.

- The space between each entry reflect the setup estimation time as configured on that iPC (Edit
> Options > Estimation).

+  When you use the filter, the jobs that don't match the search criteria are dimmed.

«  When the iPC operator starts a job that was not shown as the first one in this (and his) queue,
then that job automatically re-positions itself to the front of the queue.

List View

10
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This view makes it easier to read details and to sort entries before selecting them. Most of the
information is retrieved from iPC.

Note: Asin many views in the Pilot, you can

« re-arrange columns by dragging their title to a new position

» sort them by clicking on a column title

« right-click a column title and choose to Hide this one or any other. In the list that appears, select
Select Columns... if you want to change or re-arrange multiple items.

« use filters and optionally save them as a Smart View.

« define your preferred unit in Edit > Preferences > Units.

The shown units follow the choice you made for this Pilot in Edit > Preferences > Units.
Possible statuses:

- [ Waiting for verification: This is shown when status in iPC is "Pending for estimation” or "Check
if ready for production”. *

« % Not ready for production: For example the job was submitted but iPC could not determine the
cutting line in the PDF because it was set in the wrong spot color.

. Ready for production: In the queue to be produced.
+ @ Started: Being produced.
« M Paused: For example because a new sheet is needed before continuing the job.

- M Suspended: The job was not(completely) done yet, but another job will be produced first.

Conditional Coloring

In Time Line view, coloring the entries helps to get a quicker understanding of the queues. You could
for example set a color per type of Material or per Tooling Preset. See an example in above screenshot.

Follow these steps to color entries (for all available Kongsberg tables):

Right-click the name of any of the tables and choose Conditional Coloring.
Add one or more rules.

Use Move up/down to control the order in which they are executed. For example, when the first rule
colors some entries red, then the second rule can only affect the other entries, etc.

Deleting, Moving and Splitting Jobs

Tip: Selections that you make remain active when you switch the = / = view modes. An example:
Inthe = List view mode, sort per column and then make a multiple selection. Then switch to the =
Time Line view mode where the selection is kept and then move the selected entries to the front of the
queue.

n
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1 Attention: There is no 'undo' for any of these functions.

Note: When making these changes, both the related Views in the Pilot and the list of jobs on the
respective iPC stations update automatically.

Tip: You can also execute below mentioned actions on selections that you made with the filter.

When entering a search text in the filter, the search is done on the job's Name and Material.

- Deleting Jobs. Select and press 'Delete’(or right-click and choose 'Delete’) to delete jobs from the
queue. This also deletes them from the iPC job list. You will be asked to confirm.

Note: When ajobisopeniniPC, it cannot be removed.

In the Sheets view, the deleted jobs will show up as [:1'Aborted'.

« Moving ajob to a different position in the same queue. You can re-arrange the queue by using drag
and drop, even on multiple selected jobs. This also updates their order in the iPC jobs list.
To move a job to the front of the queue, right-click the job and choose 'Cut Next'.

« Moving ajob to a different queue. When a table needs to undergo maintenance, or when you
manually want to balance the production load, you can drag and drop one or multiple queue entries
to another table queue.

Note: When ajobisopeniniPC, it cannot be moved to another queue.

Note: This function requires aniPC version higher than 2.0.

- Splitting a Job. Another way to manually balance the workload of your tables, is to split ajob. A job
that requires a large number of sheets to be produced, can so be spread over multiple tables.

Follow these steps:

1. Inthe queue(bothin List orin Time Line view), right-click a job and choose Split Job....

2. The 'Split Job' dialog opens. By default, the job will be split in two parts each having half of the
total number of copies.
+ Click +to splitinto more parts.
+ Click=-toremove the selected part.

- Slide the resize control (the small circle) to the left or right to modify the number of copies of
those parts.

« Enter the number of Copies in the edit field. Press 'Tab'to confirm the value. Press 'Enter'to
Split the job and close the dialog.

© Split Job |

To split a cutting job, drag the resize control and press Split.

* Coples: 200
200 155

e [ spit || cancel

12
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3. Click Split to confirm and close the dialog.

Note: When ajobisopeniniPC, it cannot be split.

2.3. Sheets

Concept
The Sheets view gives a historical overview of all jobs that were produced on your Kongsberg tables. It
shows all closed jobs in iPC, both those successfully finished and those aborted during cutting.

Each sheet is a row. Each entry gives information about a cutting job and how it was processed on the
table: start and finish time, number of copies produced, table name etc.

This view does not do live updates. To see updates of newly finished jobs, refresh the view via View >
Refresh or press F5 or CMD-R .

When a table was offline when it finished a job, the sheet entry will show up in this view once the
connection has been restored.

Entriesin this view are cleaned up automatically according to the rule set in the Configure tool item for
Devices database.

The details pane on the right shows a preview and some key properties of the selected sheet (drag its
left edge to enlarge it).

The bottom bar indicates how many sheets there are (total or selected or filtered).

File Edit View Go Job Tools Advanced Help

< » = 83 & |WDE Graphics | | o~
| [ Files (WDE G... | 51 Tasks EZ Sheets E5 Sheets (WDE ... [ Files (WDE G... + |
I+ General Search: [All Name Material Operator Hide Criteria | Done Save | -
1= Sign & Display Material * contains =
(& Orders
B Gang Run Printing Name Material Coples Operator State Started Date  Finished Date / @m m
[ CTP Flexo KVHA-PVC_Small_1_13831.df  KVHA-PVC 1 kvha B 404016 11:0... 4416 11:0... - |
= Cutting Tables KVHA-PVC_Small_1_13843jdf  kvhasma.. 1 E 4416 10:4., 4/416 1543 ., - (ﬁ. m
= sheets A3_A3_50_04204.jdf A3 50 kvha = 4116 5:13 .. 41416513 .. L
J& Table Queuss KVHA-PVC_Small_1_13824.jdf  KVHA-PYC 1 kvha = 4/1/16 4:50 ... 4/1/16 4:50 ..,
" Smart Views KVHA-PVC_Small_1_13818.jdf  KVHA-PVC 1 kvha T 4/1/16 443 ... 4/1/16 4:43 ... ! f;
= Setup KVHA-PVC_Small_1_13797.jdf 1 3 B 4/1/16 4:27 ... 4/1/16 4:27 ... @ [ | =] m BE
¥ Devices KVHA-PVC_Small_1_13801.jdf  KVHA-PVC 1 kvha B4/1/16 4:25 ... 4/1/16 4:26 ...
& FlexRips KVHA-PYVC_Small_1_13799.jdf EVHA-PVC 1 kvha m 4/1/16 4:25 ... 4/1/164:25 ...
7 Queue Monitor  KVHA-PYC_Small_1_13772jdf  KVHA-PVC 1 kvha m 4f1/164:20 ... 4/1/164:20 ... Name: KVHA-PVC_Small_1_1...
@ Containers KVHA-PVC Large 1_13733df  KVHA-PVC 1 kvha ® 4]1/16 3:57 ... 4/1/163:58 .. eterial ks materia
@ Access Points KVHA-PVC_Large_6_13731jdf  KVHA-PVC 6 kvha T /116 3:57 ... 4116 3:57 ... et
NEET KVHA-PVC Large_1_137254df  KVHA-PVC i kvha = 4/1/16 3:57 ... 4/1/16 3:57 ... et dj Y
4 Users KVHA-PVC_Large_6_13727.jdf  KVHA-PYC 6 kvha = 41016 3:57 ... 4/1/16 3:57 .. ' '
KVHA-PVC _Large_1_13729jdf  KVHA-PVC 1 kvha = 4/1/16 3:56 ... 4/1/163:56 ... Cutting Profile: Default cutting profile
KVHA-PYC_Large_1_13719.jdf  KVHA-PVC 1 kvha = 4/1/16 3:56 ... 4/1/16 3:56 ... Tooling Preset: Rigid Material Knife + ..
KVHA-PVC_Large_3_13717.jdf  KVHA-PVC 3 kvha B 41/16 3:56 ... 4/1/16 3:56 ... Optirnization: Mo Optimisation
KVHA-PVC_Large_3_13721jdf  KVHA-PVC 3 kvha B 4/1/16 3:55 ... 4/1/163:55 ... . Production Setup: F7 4 L b
1 of 289 selected Server: ROVMAEL? User: wde [#15

13
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Note: Asin many views in the Pilot, you can

« re-arrange columns by dragging their title to a new position

» sort them by clicking on a column title

« right-click a column title and choose to Hide this one or any other. In the list that appears, select
Select Columns... if you want to change or re-arrange multiple items.

« use filters and optionally save them as a Smart View.

« define your preferred unit in Edit > Preferences > Units.

Columns

« Name. This is the name of the cutting job.

Note: When the name ends with . jdf, this means that this job was created by the Submit to
Kongsberg table task. Otherwise (where the name ends with .acm, .cut, .ard...) thismeans
that the job was manually added to iPC's My Jobs list or that a job entered by the task was changed
in iPC before being produced.

« Customer: When the sheet was created via a gang run queue that received a Customer ID when
files were submitted, then the corresponding customer name is used. When an ARD or MFG was
directly submitted to a Kongsberg table, the customer name is extracted from the information
inside the ARD or MFG file.

« Customer ID: This is the ID that was specified in the Submit to Gang Run task. When jobs with
different customer IDs are nested on one sheet, the sheet's customer ID will be a concatenation of
all customer IDs.

« State: Final state of the job: ® finished or [Z1 aborted.

« Operator: IPC user who started the job.

« Table Name: Name of the device on which the job was produced.
« Material: Name of the material used to produce the job.

. Copies: Total requested number of copies for this sheet/layout (as specified in the 'Submit to
Kongsberg table' ticket or as set in iPC).

Note: This example of a workflow using Gang Run helps to understand the difference between
quantities and copies.

« Copies Produced: Number of successfully produced copies of this sheet/layout.

« Copies Rejected: Number of unsuccessful copies while producing this job.

« Estimated Duration: Estimated time to produce all copies of the job.

+ Created Date: Time/date when the job was submitted in the table queue (ISO 8601 UTC).
. Started Date: Time/date when the table started cutting.

« Finished Date: Time/date when the job was finished or aborted.
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Media Height / Width: Height and width of the used sheet.

+  When the job was submitted to iPC by Automation Engine, then this is the media size as
specified in the submitted JDF (the sheet size of gang run layouts, the sheet size from
submitted MFG files, the blank size of submitted ARD files)

+  When the job was added by iPC, then iPC sets the media size.
Mapping Preset: Used to import the job oniPC.
Optimization, Cutting Profile, Production Setup, Tooling Preset: Attributes used to produce the

job.

Launching Tasks

When you right-click an entry, you can choose to launch a New Task on that entry.

When you want to produce a sheet again, choose the Submit to Kongsberg task and define its
options. Choose "From Input File" when you want a value to be taken from the input JDF, it will then
be the same as the value used before.

The Export Kongsberg Cutting History task does not base the data it exports on the entry that you
selected but only on the options that you set in the ticket. This task does require an input file
however, but does not use it for its output. This also means that there is no need to launch this task
from this view.

Choose Other... to launch another task type. Once you have launched it, this task type then also
appears in theinitial list.

1 Attention: These tasks, with exception of the Export Kongsberg Cutting History task, use the

sheet's JDF file as input file (even when the sheet Name mentions another file formatQ. These
JDF files are present in the Media Root Folder as defined in the Configure tool item for Device
Databases..

2.4. Orders

The Orders view is part of the Views category Sign & Display. This view is documented in the chapter
on Gang Run Printing for Sign & Display. Find a direct link here.
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3. Kongsberg Related Tasks

3.1. Submit To Kongsberg Table task

Concept

This task submits the input file to the My Jobs list of the chosen iPC (Kongsberg table). This also
creates an entry for this iPC job in the Table Queues view.

Note: This page is part of a separate chapter on using Automation Engine in a Kongsberg workflow. We
advise to first learn about its concepts and workflow types in this intro.

IniPC, the order of the submitted jobs is decided by the priority of this task, as was selected in the
ticket: Low, Normal, High or Imnmediate. Submitted jobs with a same priority are in iPC sorted by their
due date.

16

Input File Types

ARD or MFG files. One iPC job is created per input file. The task wraps the ARD or MFG in a JDF file
before sending it to the iPC. Learn more about this workflow in Submitting Single CAD Files on page
4,

Note: The media size of the JDF is set to the sheet size of the MFG file or to the bounding box of all
cut lines of the ARD file.

When available, the board description, grain direction and customer info is read from the ARD or
MFG file and used in the iPC job.

JDF for digital cutting. This type of JDF file is created in these two cases:

« By the Export Nested Layouts task (used in the workflow started by a Gang Run Substrate
queue).

« Orbyresubmitting a cutting job from the Sheets view.

XML cutting request. This file is created by the CDI Plate Merger and describes how the flexo

plate should be cut. Automation Engine's workflow for CDI Imagers can submit such an XML to the
Kongsberg table at the moment it is informed that the CDI plate was imaged. Learn more in Cutting
CDl plates on page 6.

Settings

Kongsberg Table: Select a table (iPC) form the list of devices that you configured earlier.

Note: The submitted job will also enter the queue even when the selected table is offline at that
moment (see its status in Device view).

Kongsberg Job Name: Define the name of the job as it will appear in the My Jobs list of the chosen
iPC.
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Due Date: You can set a due date for the job. This time will then be mentioned for that job in iPC. You
can choose an absolute or relative time.

When you select a due date "From Input File":

+  Whentheinput file isan ARD or MFG, or when the task is started from the Sheets view, then the
job is submitted without due date.

« Otherwise the value from the input JDF file is used (the cutting file type "JDF for Kongsberg"
created by the Export Nested Layouts task).

Note: A due date specified by a SmartName must resolve to a valid ISO 8601 string, i.e. the format
yyyy-mm-ddThh :mm: ss . For example 2017-03-10T10:00:00 .

Copies: Define the number of sheets to cut. When you keep the default "From Input File", this
number will be taken from the input file's attributes. When no such information is available, the
amount will be 1.

Note: When the task is started by resubmitting it from the Sheets view, "From Input File" then re-
uses the previously used value (as present in the input JDF file).

Material, Mapping Preset and Cutting Profile: Click El to select the wanted resource from the list.
This list is automatically updated with the resources you created in iPC.

Note: When you here type in the name of a resource that does not exist, it will show up in iPC's Job

Info with this warning icon:

Note: Any changes that you doiniPC to a Job's resources are communicated to Automation
Engine. The updated settings automatically show up in the Sheets and Table Queues views.

3.2. Export Kongsberg Cutting History

Concept

This task exports information about finished cutting jobs to an XML file. External systems can use
these XML reports to get job status information or calculate production statistics.

Note: This tasks needs an input file. However, the only use of this input file is to resolve the
SmartName [File] inthe setting File Name.

You can launch this task manually or as part of a workflow. An external system can decide to launch it
itself by using a Web Service Access Point.

Note: The task always runs outside of a Job context, even when launched from within an Automation
Engine Job.

Settings

Output in: When no folder is specified, the file is written in the root folder of the
ExampledJobContainer.

File Name: Use SmartNames to define the name of the output XML. When that XML already exists,
itis overwritten and the task ends with a warning.

17
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« [File] resultsinthe name of the task's input file.
+ [File Number] isrelevant when you use the advanced option Records per File (see below).

« In Export history records that match the following criteria, create one or multiple rules that
specify which kind of data should be exported.

This filter tool is the same as used to create view filters in many places in the Pilot. See an example
on filtering here.
« Advanced.... These options define the structure of the XML.

+ Columns: Click on El to select which columns you want to export into the XML file. By default, all
columns are exported.

Note: When using a SmartName, it needs to resolve to the internal name(s) of the column(s). To
find these internal names, right-click in the Columns field, choose Copy Parameter Value and
paste this in a text file.

« SortBy: Select a column type by which you want to sort the jobs.
+ Order: Select the order of the columns.
« Records per File: Define the maximum of records that the XML file may contain. When there are

more records than that number, extra XML files are created and they get an extra number at the
end of their name (using the SmartName [File Number]).

Example

18



ESKO

Automation Engine

<?xml version="1.0" encoding="UTF-8" 7>
- <=

-
- <Cutlobs>

- <Cutlob>
<Operator>Administrator</Operator>
<Status>FINISHED</Status>
<CreationDate >2016-03-08T13:39:15.773Z</CreationDate>
<AmountProduced>1</AmountProduced>
<Optimisation>SampleMaking</Optimisation>
<Amount>1</Amount>
<ProductID>Test</ProductID>
<Mapping >Default mapping</Mapping>
<FinishDate >2016-03-21T07:38:16.018Z</FinishDate>
<CuttingProfile>SBS 350g</CuttingProfile >
<Narme>Test_2000x2000_1_7322.jdf</Name>
<StartDate>2016-03-21T07:38:04.6272Z</StartDate>
<TableName >rdvmae14</TableName >
<EstimatedCuttingTime >587 </EstimatedCuttingTime>
<ToolingPreset >Rigid Material Knife + Crease </ToolingPreset>
<IDFields><?xml version="1.0" encoding="UTF-8"? ><IdentificationFields > </ IdentificationFields> </ IDFields>
<JobPartID>AmericanCars-Test_2000x2000_1_7322</JobPartID>
<MediaY >2000.0</MediaY >
<MediaX>2000.0</MediaX >
<ProductionSetup>Multi-zone</ProductionSetup>
<EstimatedBeforeFirstCopy>29 </EstimatedBeforeFirstCopy>
<ID>57821cfe-ef3b-4a5f-a634-9b3712df0ae6</ID>
<JoblD>AmericanCars</JoblD>
<EstimatedAfterLastCopy>58</EstimatedAfterLastCopy>

</Cutlob>

+ <Cutlob>

+ <Cutlob>

+ <CutJob>

Note: Dates and times are described in the format of ISO 8601(YYYY-MM-DDThh:mm:ssTZD).

Note: The elements JoblD, JobPartID and ProductID do not relate to Automation Engine's Job or
Product concepts, but to terminology in iPC.
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4. Workflow Example

This example helps to clarify terms like quantity, copies, layouts, order, JOF and sheets.

We here illustrate a workflow where the Gang Run mode creates layouts of what needs to be printed
and where the printed sheets are then cut on a Kongsberg table.

Note: This example workflow does not include steps like creating an Automation Engine Job, arrival
and preflighting of the graphics, an approval stage nor feedback to a business system.

Each step provides links to pages describing the used features.

4.1. Step1-The Order

Your sales department confirms a production order for 50 large Esko logos on thick PVC material.

A PDF was delivered with a correct trim box. The PDF is small and needs to be printed 10 times bigger.

4.2. Step 2a - Submitting the PDF to the Gang Run

20

The PDF with the Esko logo is submitted to a gang run queue, requesting a Quantity of "50". The Orders
view immediately shows this new entry.

These steps are needed:

1. Create a substrate queue for the requested PVC material. Add available sizes and define its nesting
settings.
2. Create the queue's output workflow. You minimally need these steps and options:

o > [ © — v
ﬁ AL —— o—
Start Export Nested @ o OK
Layouts @ Submitto

Kongsberg Table

« Inthe Export Nested Layouts step, set the option Save Cutting Files to "JDF File (Kongsberg)".

« The output pin for the cutting files continues to the Submit to Kongsberg Table step.

+ Inthe Submit to Kongsberg Table step, make sure you keep the option Copies to "From Input
File".

Attach the created workflow to the substrate queue.

4. InFiles view, select the PDF and open a Submit to Gang Run ticket.

o
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+

{x100

Define a Quantity of 50 and Scale the file to 1000%. Request that the cut path will be created
from the file's trim box.

Settings for Step: Submit to Gang Run

a
General  Back | Substrate | Extra

Quantity: 50

Maximum Fill

Scale:  1000%

Rotation: Set by Substrate Queue ':

[l

[

Cut Path from Ink:

=[]
A comma separated list of ink names.

The first matching ink will be usedto create a cut path.
If no ink is found 7 Create cut path from CAD object or trim box

Due Date: [Today ~ at|12:00 AM -

In the Extra tab, enter a logic Order ID.

5. Launch the Submit to Gang Run task.

4.3. Step 2b - First Appearance in the Orders View

As soon as the PDF is submitted to a substrate queue, a new item appears in the Orders view. This
initial status shows that all of the requested quantity is still"In Gang Run".

Layouts are usually calculated quickly, after which the status changes again, which is why this status is
only visible briefly.
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| & orders

Order ID: 1106 Esko logo
Quantity: 50

Customer Name: 0012
Due Date: 5/11/16 12:00 AM

[+ In Gang Run: 1 =

[+ One-Ups: 1
[+ Layouts: 0

4.4, Step 3 - Quantity vs. Layouts

In our example that requests a Quantity of 50 logos, the substrate queue decides, based on its
substrate sheet size, to create 2 Layouts:

- Tlayout PDFPLA file with 8 logos, representing the sheet that needs to be printed 6 times (totaling
48 logos).

« llayout PDFPLA file with the remaining 2 logos, representing the sheet that needs to be printed 1
time.
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4.5. Step 4 -Files Created

The output workflow of the substrate queue starts with creating the files that are needed to print and
to cut this order.

The Export Nested Layouts task creates:

+ 2 PDF files(one with 8 logos and one with 2 logos)
« 2 JDF files and 2 cutting files. Each JDF includes a reference to its own cutting file:

one describes how to cut a sheet with 8 logos

one describes how to cut a sheet with 2 logos.

In the Orders view, you can see the new status "in Output Workflow" and the names of the created files:

Orders (WDE... + :

In Qutput vV

1

|
(]
Order ID: 1106 Esko logo
Quantity: 50

Customer Name: 0012
Due Date: 5/11/16 12:00 AM

=/l In Output Workflow: 2 =
PVC 5mm jobs_Extra Large_1_1019294320.pdfpla
PVC 5mm jobs_Extra Large_8_1019293513 8.pdfpla

=/ One-Ups: 1
Esko_Neg CMYK.pdf i

=l Layouts: 2
PVC 5mm jobs_Extra Large_1_1019294320.pdfpla
PVC 5mm jobs_Extra Large_8_1019293513 8.pdfpla i
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4.6. Step 5-Each JDF is a Job entry in the Table Queues
view

A JDF (Job Definition Format) file describes what needs to happen and also assures the bidirectional
communication between Automation Engine and the iPC.

The output workflow ends by submitting the 2 JDF files to the Kongsberg table.

Stat  ExportNested @ oK
Layouts © Submit to
Kongsberg Table

Two job entries immediately appear in the Table Queues view.

In below screenshot, see how one job entry looks much larger than the other. The selected entry needs
to cut 8 copies of the PVC "sheet" containing 6 logos and will therefore take much longer to produce
than the other one:

[l Table Queues + |
Kongsberg Tables P I I -|:_-JI| M I I I I 5000 | o
] f ==K0® | ESKO
o = [
XN 40 A3 3| | KVHAP | BVHA. | [ UHAR| A3 A2 00 | A2 A3 oo (A3 A2 | (A2 | A3 [winyl | | A3_A3) ESKG @ E SKG @

ESKOS

Name: PYC 5mm jobs_Extra Large 27370.jdf

Malerial: kvha's material

State: Ready for production
Finishes at: 4:09 PM

4.7. Step 6 - Logos are Printed and Moved to the Table

24

The 2 print PDF files created by the Export Nested Layouts task are printed.

The 9 sheets (8 copies and 1copy) are made available near the Kongsberg table.
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ESKOD | ESKDS
ESKODS | ESKOS
ESKD | ESKOS

4.8. Step 7-The iPC Operator Produces the Jobs

The iPC operator places the printed PVC sheet on the table and starts the matching cutting job for that

type of sheet.
@

% Job 1 - copies 8

[:I:| Job 2 - copies 1

4.9. Step 8 - The Sheets View shows the Production Results

When the iPC has finished producing a job, this job appears in the Sheets view.

In below screenshot, the Sheets view shows that both jobs were produced and also shows how many
copies of that type of sheet were produced.

| E5 Sheets | I Table Queues | & Orders ) Tasks |+

Mame Customer ID Copies Copies Produced State Started Date  Finished...
5/11/16 4:4... 5/11/16... |8

PVC 5mm jobs_Extra Large_1_27372.... 0012
PVC Smm jobs_Extra Large_8_27370.... 0012 8 8 ® 5/11/164:3... 5/11/16...

Mame: PVC 5mm jobs_Exira La...

Material: kvha's material
Coples: 1
Created: 5/11/16 10:15 AM
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